About this Book



This manual’s goal is to save you time. It will get you started
    using GnuCash as quickly as possible.
Each chapter follows a simple format. A chapter begins with a
    “Concepts” discussion which introduces general themes and
    terminology, addressed and used within that chapter. “How-To”
    sections, which address specific procedures follow. Finally, a
    “Putting It All Together” section ends the chapter by giving
    detailed, concrete examples.
Beginning users will find the “Concepts” sections very
    helpful. They provide a reference for good ways to track your finances,
    and serve as a general introduction to financial background and
    terminology. Experienced users can flip to the “How-To”
    sections to quickly scan procedures. These sections provide to-the-point
    steps for accomplishing specific tasks. The “Putting It All
    Together” sections present real-world examples in the form of a
    tutorial. Beginning with creation of a file in Chapter 2, The Basics, 
    each successive chapter builds on the previous chapter’s tutorial.
This manual is organized into 3 main parts: 
	Getting Started

	Managing Your Personal Finances

	Managing Your Business Finances.



Getting Started provides you with the most
    basic information needed to begin using GnuCash. Use this part as a
    quick-start guide. Its chapters will get you up and running: 
	Chapter 1, Overview

	Chapter 2, The Basics

	Chapter 3, Accounts

	Chapter 4, Transactions



Managing Your Personal Finances addresses
    common applications and features of GnuCash in greater detail. You will
    see more specific cases, based on frequently asked questions about
    applying GnuCash to everyday situations. Here are the applications and
    features covered in this part: 
	Chapter 5, Checkbook

	Chapter 6, Credit Cards

	Chapter 7, Loans

	Chapter 8, Investments

	Chapter 9, Capital Gains

	Chapter 10, Multiple Currencies



Managing Your Business Finances discusses the
    use of GnuCash in business accounting: 
	Chapter 11, Depreciation

	Chapter 12, Accounts Receivable

	Chapter 13, Accounts Payable

	Chapter 14, Payroll

	Chapter 15, Budgets

	Chapter 16, Other Assets



This manual also has an appendix, which contains extra information
    you might want to know:
	Appendix A, Migration Guide - Guide for former Quicken®, MS Money or other QIF
        users

	Appendix B, Frequently Asked Questions

	Appendix C, Contributed Account Trees

	Appendix D, Auxiliary File Formats

	Appendix E, GNU Free Documentation License



Last, but not least, a glossary and index help you quickly locate
    topics.

Installation



Installation of GnuCash can be simple, as most modern linux
    distributions come with GnuCash precompiled and ready to go. In fact, most
    likely, GnuCash is already installed. If you do not have GnuCash
    installed, the simplest method for installing it is to insert the
    installation CD that came with your distribution and follow the
    instructions.
The GnuCash home
    page contains detailed instructions on how to install
    GnuCash in the event your current distribution does not include it or you
    want to install a different version. You can also read the README file in
    the source code.

Chapter 2. The Basics



This chapter will introduce some of the basics of using GnuCash. It is
  recommended that you read through this chapter, before starting to do any
  real work with GnuCash. Next chapters will begin to show
  you hands on examples.
Accounting Concepts



GnuCash is easy enough to use that you do not need to have a
    complete understanding of accounting principles to find it useful.
    However, you will find that some basic accounting knowledge will prove to
    be invaluable as GnuCash was designed using these principles as a
    template. It is highly recommended that you understand this section of the
    guide before proceeding.
The 5 Basic Accounts



Basic accounting rules group all finance related things into 5
      fundamental types of “accounts”. That is, everything that
      accounting deals with can be placed into one of these 5 accounts:
Account types
	Assets
	Things you own

	Liabilities
	Things you owe

	Equity
	Overall net worth

	Income
	Increases the value of your
            accounts

	Expenses
	Decreases the value of your
            accounts



It is clear that it is possible to categorize your financial world
      into these 5 groups. For example, the cash in your bank account is an
      asset, your mortgage is a liability, your paycheck is income, and the
      cost of dinner last night is an expense.

The Accounting Equation



With the 5 basic accounts defined, what is the relationship
      between them? How does one type of account affect the others? Firstly,
      equity is defined by assets and liability. That is, your net worth is
      calculated by subtracting your liabilities from your assets:
Assets - Liabilities = Equity
Furthermore, you can increase your equity through income, and
      decrease equity through expenses. This makes sense of course, when you
      receive a paycheck you become “richer” and when you pay for dinner you
      become “poorer”. This is expressed mathematically in what is known as
      the Accounting Equation:
Assets - Liabilities = Equity + (Income -
      Expenses)
This equation must always be balanced, a condition that can only
      be satisfied if you enter values to multiple accounts. For example: if
      you receive money in the form of income you must see an equal increase
      in your assets. As another example, you could have an increase in assets
      if you have a parallel increase in liabilities.
Figure 2.1. The basic accounts relationships
[image: The basic accounts relationships]A graphical view of the relationship between the 5 basic
              accounts. Net worth (equity) increases through income and
              decreases through expenses. The arrows represent the movement of
              value.







Double Entry



The accounting equation is the very heart of a double entry
      accounting system. For every change in value of one account in the
      Accounting Equation, there must be a balancing change in another. This
      concept is known as the Principle of Balance, and
      is of fundamental importance for understanding GnuCash and other double
      entry accounting systems. When you work with GnuCash, you will always be
      concerned with at least 2 accounts, to keep the accounting equation
      balanced.
Balancing changes (or transfers of money) among accounts are
      done by debiting one account and simultaneously crediting another.
      Accounting debits and
      credits do not mean “decrease”
      and “increase”. Debits and credits each increase certain
      types of accounts and decrease others. In asset and expense accounts,
      debits increase the balance and credits decrease the balance. In
      liability, equity and income accounts, credits increase the balance
      and debits decrease the balance.
In traditional double-entry accounting, the left column in the
      register is used for debits, while the right column is used for credits.
      Accountants record increases in asset, expense, and equity accounts on the
      debit (left) side, and they record increases in liability, revenue, and capital
      accounts on the credit (right) side. GnuCash
      follows this convention in the register.
Note
This accounting terminology can be confusing to new users,
        which is why GnuCash allows you to use the
        common terms Deposit and
        Withdrawal. If you prefer the formal accounting
        terms, you can change the account register column headings to use
        them in the General tab under
        Preferences (see the
        GnuCash Help Manual for more information on
        setting preferences).

Warning
Common use of the words debit and credit 
        does not match how accountants use these words. In common use, 
        credit generally has positive associations; in accounting,
        credit is associated with decreases in asset,
        expense and equity accounts.




Data Entry Concepts



When entering data in GnuCash, you should be aware of the 3 levels
    of organization in which GnuCash divides your data: files, accounts and
    transactions. These levels are presented in their order of complexity, one
    file contains many accounts and one account contains many transactions.
    This division is fundamental to understanding how to use GnuCash.
Files



GnuCash stores information at the
      highest level in files. A file can be stored on your computer either
      as a single XML file (in all versions of
      GnuCash), or in a SQL
      database (in GnuCash version 2.4 and higher).
Note
SQL is pronounced “sequel”,
        so in spoken and written language we would say “a SQL
        database”.

With the XML file format,
      GnuCash stores your data in an
      XML data file, usually in compressed format
      (although this can be changed in the General
      tab of the GnuCash Preferences).
With SQL storage,
      GnuCash stores your data in a
      SQL database under the database application you
      select (SQLite3, MySQL or PostgreSQL).
You will need one main file or database for each set of
      accounts you are maintaining. To learn how to create and manage
      GnuCash files, see the section called “Storing your financial data”.
Note
If you think you might need more than one set of accounts,
        you might want to consult a professional accountant or bookkeeper
        before proceeding. Most users will probably have only one data
        file.

Backup files and log files are automatically generated by
      GnuCash when appropriate. Backup and log
      files are described in the section called “Backing Up and Recovering Data”.

Accounts



An account keeps track of what you own,
      owe, spend or receive. Each GnuCash file can
      contain any number of accounts, and each account can contain many
      sub-accounts up to an arbitrary number of levels. This simple feature
      gives GnuCash much of its power in managing
      your finances, as you will see in later chapters.
Examples of accounts include: checking accounts, savings
      accounts, credit card accounts, mortgages, and loans. Each
      GnuCash account tracks the activity for that
      “real” account, and can inform you of its status.
In addition, accounts are also used to categorize the money you
      receive or spend. For example, you can create expense accounts to
      track the money you pay on utilities or groceries. Even though these
      are not accounts that receive statements, they allow you to determine
      how much money is being spent in each of these areas.
Accounts will be covered in more detail in Chapter 3, Accounts.

Transactions



A transaction represents the movement of
      money among accounts. Whenever you spend or receive money, or
      transfer money between accounts, that is a transaction.
Examples of transactions are: paying a phone bill, transferring
      money from savings to checking, buying a pizza, withdrawing money,
      and depositing a paycheck. Chapter 4, Transactions goes more
      in depth on how to enter transactions.
In double entry accounting, 
      transactions always involve at least two accounts–a source 
      account and a destination account.
      GnuCash manages this by inserting a line
      into the transaction for every account that is affected, and
      recording the amounts involved in each line. A line within a
      transaction that records the account and amount of money involved is
      called a split. A transaction can contain an
      arbitrary number of splits.
Note
Splits in transactions will be covered in the section called “Split Transaction”



Migrating GnuCash data



Sometimes you may need to move your financial data and GnuCash settings to another machine.
      Typical use cases are when you buy a new computer or if you want to use the same settings over two different operating 
      systems in a dual boot configuration.
Migrating financial data



Migrating GnuCash financial data is a as simple as copying  .gnucash 
     files with a file manager if you know where they are saved. If you can’t remember where a file is stored 
     but you can open it directly within GnuCash, save it in the desired path from within
     GnuCash.
All other files in the folder are either backups or log files. It won’t do any harm to copy them too, but it’s not likely
     to do any good, either.

Migrating preferences data



Preferences are stored in three different locations: one for GnuCash preferences, 
     one for reports, and one for online banking settings. Preferences are managed by
     gsettings, reports are managed by GnuCash 
     itself, and online banking is managed by aqbanking. If you do not use online banking,
     then you will not have this folder on your machine.
Where the GnuCash preferences are stored varies
     depending on your operating system (see Table 2.1, “Application Settings Locations”, Table 2.2, “Saved Reports Locations”, and 
     Table 2.3, “Online Banking Settings Locations”). To back up and transfer your entire installation, you must copy
     these preferences as well.
Table 2.1. Application Settings Locations
	Operating system	folder
	Unix	GnuCash preferences are stored in dconf.
                  You can use the commands dconf dump /org/gnucash/ on the old machine
                  and dconf load /org/gnucash/ on the new machine to migrate your preferences.
	Mac OSX	~/Library/Preferences/gnucash.plist
	Windows	The preferences are stored in the Windows registryHKEY_CURRENT_USER/software/GSettings




Table 2.2. Saved Reports Locations
	Operating system	folder
	Unix	~/.gnucash
	Mac OSX	~/Library/Application Support/gnucash
	Windows	Documents and Settings/Username/.gnucash or
                     Users/Username/.gnucash




Table 2.3. Online Banking Settings Locations
	Operating system	folder
	Unix	~/.aqbanking
	Mac OSX	~/.aqbanking
	Windows	Documents and Settings/Username/.aqbanking




Note
On Unix and Mac OSX, these folders will generally not
       display in the file manager. You must set the file manager to show hidden files
       and folders to see them.

Tip
On Unix and Mac OSX, the ~ symbol means the 
       home folder.



GnuCash Accounts



This section will show how the GnuCash definition of an account fits
    into the view of the 5 basic accounting types.
But first, let’s begin with a definition of an
    account in GnuCash. A GnuCash
    account is an entity which contains other
    sub-accounts, or that contains transactions. Since an
    account can contain other accounts, you often see account
    trees in GnuCash, in which logically associated accounts are grouped
    together within a common parent account.
A GnuCash account must have a unique name (that you assign) and one
    of the predefined GnuCash “account types”. There are a total of 12 account
    types in GnuCash. These 12 account types are based on the 5 basic
    accounting types; the reason there are more GnuCash account types than
    basic accounting types is that this allows GnuCash to perform specialized
    tracking and handling of certain accounts. There are 6 asset accounts
    (Cash, Bank,
    Stock, Mutual Fund,
    Accounts Receivable, and Other Assets),
    3 liability accounts (Credit Card,
    Accounts Payable, and Liability),
    1 equity account (Equity), 1 income account
    (Income), and 1 expense account
    (Expense).
These GnuCash account types are presented in more detail
    below.
Balance Sheet Accounts



The first balance sheet account we will examine is
      Assets, which, as you remember from the previous
      section, refers to things you own.
To help you organize your asset accounts and to simplify
      transaction entry, GnuCash supports several types of asset
      accounts:
	Cash Use this account to track the money
          you have on hand, in your wallet, in your piggy bank, under your
          mattress, or wherever you choose to keep it handy. This is the most
          liquid, or easily traded, type of asset.

	Bank This account is used to track your
          cash balance that you keep in institutions such as banks, credit
          unions, savings and loan, or brokerage firms - wherever someone else
          safeguards your money. This is the second most
          liquid type of account, because you can easily
          convert it to cash on hand.

	Stock Track your individual stocks and
          bonds using this type of account. The stock account’s register
          provides extra columns for entering number of shares and price of
          your investment. With these types of assets, you may not be able to
          easily convert them to cash unless you can find a buyer, and you are
          not guaranteed to get the same amount of cash you paid for
          them.

	Mutual Fund This is similar to the stock
          account, except that it is used to track funds. Its account register
          provides the same extra columns for entering share and price
          information. Funds represent ownership shares of a variety of
          investments, and like stocks they do not offer any guaranteed cash
          value.

	Accounts Receivable (A/Receivable) This
          is typically a business use only account in which you place
          outstanding debts owed to you. It is considered an asset because you
          should be able to count on these funds arriving.

	Other Assets No matter how diverse they
          are, GnuCash handles many other situations easily. The group
          category, “Other Assets”, covers all assets not listed above.
Accounts are repositories of information used to track or record
          the kinds of actions that occur related to the purpose for which the
          account is established.
For businesses, activities being tracked and reported are
          frequently subdivided more finely than what has been considered thus
          far. For a more developed treatment of the possibilities, please read
          the descriptions presented in
          Chapter 16, Other Assets of this Guide.
For personal finances a person can follow the business groupings
          or not, as they seem useful to the activities the person is tracking
          and to the kind of reporting that person needs to have to manage his
          financial assets. For additional information, consult
          Chapter 16, Other Assets of this Guide.



The second balance sheet account is
      Liabilities, which as you recall, refers to what
      you owe, money you have borrowed and are obligated to pay back some day.
      These represent the rights of your lenders to obtain repayment from you.
      Tracking the liability balances lets you know how much debt you have at
      a given point in time.
GnuCash offers three liability account types:
	Credit Card Use this to track your credit
          card receipts and reconcile your credit card statements. Credit
          cards represent a short-term loan that you are obligated to repay to
          the credit card company. This type of account can also be used for
          other short-term loans such as a line of credit from your
          bank.

	Accounts Payable (A/Payable) This is
          typically a business use only account in which you place bills you
          have yet to pay.

	Liability Use this type of account for
          all other loans, generally larger long-term loans such as a mortgage
          or vehicle loan. This account can help you keep track of how much
          you owe and how much you have already repaid.



Tip
Liabilities in accounting act in an opposite manner from assets:
        credits (right-column value entries) increase
        liability account balances and debits
        (left-column value entries) decrease them. (See note later in this
        chapter)

The final balance sheet account is Equity,
      which is synonymous with “net worth”. It represents what is left over
      after you subtract your liabilities from your assets, so it is the
      portion of your assets that you own outright, without any debt. In
      GnuCash, use this type of account as the source of your opening bank
      balances, because these balances represent your beginning net
      worth.
There is usually only a single GnuCash equity account, called naturally
      enough, Equity. 
      For companies, cooperatives etc. you can create a subaccount for each partner.
Tip
In equity accounts, credits increase account balances and debits
        decrease them. (See note later in this chapter)

Note
The accounting equation that links balance-sheet accounts is
        Assets = Liabilities + Equity or rearranged Assets - Liabilities =
        Equity. So, in common terms, the things you own
        minus the things you owe equals your
        net worth.


Income and Expense Accounts



Income is the payment you receive for your
      time, services you provide, or the use of your money. In GnuCash, use an
      Income type account to track these.
Tip
Credits increase income account balances and debits decrease
        them. As described in the section called “Accounting Concepts”, 
        credits represent money transferred
        from an account. So in these special income
        accounts, when you transfer money from (credit)
        the income account to another account, the balance of the income
        account increases. For example, when you deposit
        a paycheck and record the transaction as a transfer from an income
        account to a bank account, the balances of both accounts
        increase.

Expenses refer to money you spend to purchase
      goods or services provided by someone else. In GnuCash, use an
      Expense type account to track your expenses.
Tip
Debits increase expense account balances and credits decrease
        them. (See note later in this chapter.)

Note
When you subtract total expenses from total income for a time
        period, you get net income. This net income is then added to the
        balance sheet as retained earnings, which is a type of
        Equity account.

Below are the standard Income and
      Expense accounts after selecting Common
      Accounts in the assistant for creating a new Account Hierarchy
      (Actions → New Account 
      Hierarchy...).
[image: Default income accounts]This image shows the standard Income
              accounts



[image: Some default expense accounts]This image shows some standard Expenses
              accounts





Entering Deposits



Most deposit transactions are entered as a transfer from an income
    account to a bank account. Income may come from many sources, and it’s a
    good idea to set up a separate income type account for each different
    source. For example, your income may come mainly from your paychecks, but
    you may also receive interest on your savings. In this case, you should
    have one income account for salary and another income account for interest
    income.
Tip
Be sure to check the Tax-Related box and assign an appropriate tax
      category in the Income Tax Information Dialog (Edit → Tax 
      Report Options)
      when you set up taxable income accounts. Some types of income,
      such as gift income, may not be considered taxable, so check the
      appropriate tax rules to determine what is taxable. For ways to track
      capital gains income, refer to Chapter 9, Capital Gains.

Before you start entering paycheck deposits, decide how much detail
    you want to track. The basic level of detail is to enter your net pay,
    just like you would in your paper register. This is easiest, but you can
    get even more information out of GnuCash if you enter your gross pay with
    deductions. It takes a bit more effort to enter the deductions, but
    entering your tax withholding information throughout the year allows you
    to run useful tax status reports in GnuCash at any time. These reports can
    help you determine whether you are withholding enough tax, and they can
    help you estimate your tax bill ahead of time. If you are unsure about the
    level of detail, start by entering net pay. You can always go back and
    edit your transactions later if you decide you want more detail.

Putting It All Together



Now that we have covered the basic ideas behind the various
    transactions you must make to successfully track your credit card in
    GnuCash, let’s go through an example. In this example, we will make credit
    card purchases, refund two of the purchases, get charged interest on
    the unpaid balance, reconcile the credit card account, and finally make a
    partial payoff of the credit card.
Open GnuCash file



Start with opening the previous datafile we stored,
      gcashdata_5, and store it as
      gcashdata_6 directly. The main window should look
      something like this: 
[image: Starting account structure]Starting account structure for tracking a credit card in the
          putting it all together example.




Purchases



Let’s make some purchases on our visa card. Start by buying $25
      worth of food from the Greasy Spoon Cafe, $100 worth of clothing from
      Faux Pas Fashions, $25 worth of gasoline from Premium Gasoline, $125
      worth of groceries and household items from Groceries R Us (split
      between $85 in groceries and $40 in household items) and finally, $60
      worth of household items from CheapMart.
We also redo the exercise in previous chapter, with purchasing
      a pair of Jeans for $74.99 on April 3, and refund them two days later.
The register window for the credit card liability should look like this:
[image: Initial credit card purchases]Initial credit card purchases.




Refund



Now suppose that on April 15th you return the clothes you bought
      on April 11th from Faux Pas Fashions and they give you credit back on
      your credit card. Enter a transaction for the credit card refund for the
      full $100 amount. Remember to use the same transfer account you used for
      the original purchase, and enter the amount under the Payment column.
      GnuCash will automatically complete the name and transfer account for
      you, but it will also automatically enter the $100 in the Charge column.
      You will need to reenter the amount in the Payment column. The
      transaction looks like this:
[image: Item return transaction]Returning clothes to Faux Pas Fashions, refund to credit
            card.




Interest Charge



After the month of spending, unfortunately, the credit card bill
      arrives in the mail or you access it on-line through the internet. You
      have been charged $20 in interest on the last day of April because of
      the balance you carried from the previous month. This gets entered into
      the credit card account as an expense.
[image: Interest charge]Interest charge.




Reconciliation



When your credit card bill arrives you should reconcile your
      credit card account to this document. This is done using GnuCash’s
      built-in reconciliation application. Highlight the credit card account
      and click on Actions → Reconcile.... This reconciliation procedure is
      described in detail in the the section called “Reconciliation”, 
      but we will step
      through the process here as well. For this example, let’s assume that
      the credit card statement is dated May 1st, with a final balance of
      $455. Enter these values in to the initial Reconcile window as shown
      here.
[image: Initial reconcile window]Initial account reconciliation window.



During the reconciliation process, you check off each transaction
      in the account as you confirm that the transaction appears in both your
      GnuCash account and the credit card statement. For this example, as
      shown in the figure below, there is a $300 difference between your
      GnuCash accounts and the credit card statement.
[image: Main reconcile window]Main account reconciliation window, demonstrating a
            discrepancy of $300.



Some investigation uncovers that you forgot to record a payment
      you made on March 5th to the credit card company for $300, you
      must enter this payment transaction from your bank account to the credit
      card. Now the credit card statement and your GnuCash account can be
      reconciled, with a balance of $455.

Payment



Assuming you have completed reconciliation of your credit card
      account, you need to make a payment to the credit card company. In this
      example, we owe $455 but will make a partial payment of $300 again this
      month. To do so, enter a transaction from your bank account to the
      credit card account for $300, which should reduce your credit card
      balance to $155. Your credit card account register should now appear
      like this:
[image: Reconciliation and payment]Account register after account reconciliation and
            payment.



Go back to the main window and save your file
      (gcashdata_6). Your chart of accounts is steadily
      growing, and it should now look like this:
[image: GnuCash main window]GnuCash Chart of Accounts after account reconciliation and
            payment.




Save file



Last, save the GnuCash data file (gcashdata_6).

Reports



As we did in the previous chapters, let’s have a look at a 
        Cash Flow, and a Transaction Report.
      
	First let’s have a look at the Cash Flow report
          for the liability account Visa during the month of March.
Select the cash flow report from Reports → Income & Expense → Cash Flow.
          
[image: Cash Flow report for the month of March]This image shows the Cash Flow report after 
                Chapter 6, Credit Cards.




	Now let’s have a look at corresponding transaction report for the Visa 
            account.
          
Select the transaction report from Reports → Transaction Report.
          
[image: Transaction Report for the Visa account during March/April]This image shows the Transaction Report for the Visa account
                  during March/April.
                




	Now let’s change the transaction report to only show the various
            Expenses accounts.
          
[image: Transaction Report for the Expenses accounts during April]This image shows the Transaction Report for the various Expense accounts
                  during April.
                








Calculations



Determining loan amortization schedules, periodic payment amounts,
    total payment value, or interest rates can be somewhat complex. To help
    facilitate these kinds of calculations, GnuCash has a built-in
    Loan Repayment Calculator. To access the calculator, go to Tools → Loan Repayment Calculator.
[image: Loan Repayment Calculator]The GnuCash Loan Repayment Calculator.



The Loan Repayment Calculator can be used to calculate any one of the
    parameters: Payment Periods, Interest
    Rate, Present Value, Periodic
    Payment, or Future Value given that the
    other 4 have been defined. You will also need to specify the compounding
    and payment methods.
	Payment Periods - the number of payment
        periods.

	Interest Rate - the nominal interest rate
        of the loan, ie: the yearly interest rate.

	Present Value - the present value of the
        loan, ie: current amount owed on the loan.

	Periodic Payment - the amount to pay per
        period.

	Future Value - the future value of the
        loan, ie: the amount owed after all payment periods are over.

	Compounding - two interest compounding
        methods exist, discrete or continuous. For discrete compounding select
        the compounding frequency from the popup menu with a range from yearly
        to daily.

	Payments - the popup menu allows you to
        select the payment frequency with a range from yearly to daily. You
        can also select whether your payments occur at the beginning or end of
        the period. Payments made at the beginning of the payment period have
        interest applied to the payment as well as any previous money paid or
        money still owed.



Example: Monthly Payments



What is your monthly payment on a $100000 30 year loan at a fixed
      rate of 4% compounded monthly?
This scenario is shown in the example image above. To perform this
      calculation, set Payment Periods to 360 (12 months x 30 years), Interest
      Rate to 4, Present Value to 100000, leave Periodic Payment empty and set
      Future Value to 0 (you do not want to owe anything at the end of the
      loan). Compounding is Monthly, Payments are Monthly, assume End of
      Period Payments, and Discrete Compounding. Now, click on the
      Calculate button next to the Periodic Payment
      area. You should see $-477.42.
Answer: You must make monthly payments of 477.42.

Example: Length of Loan



How long will you be paying back a $20000 loan at 10% fixed rate
      interest compounded monthly if you pay $500 per month?
To perform this calculation, leave Payment Periods empty, set
      Interest Rate to 10, Present Value
      to 20000, Periodic Payment is -500,
      and Future Value is 0 (you do not want to owe anything 
      at the end of the loan). Compounding is Monthly, 
      Payments are Monthly, assume End 
      of Period payments, and Discrete Compounding.
      Now, click on the Calculate. You should see 49 in the 
      Payment Periods field.
Answer: You will pay off the loan in 4 years and 1 month (49 months).

Advanced: Calculation Details



In order to discuss the mathematical formulas used by the
      Loan Repayment Calculator, we first must define some
      variables.



 n  == number of payment periods

 %i  == nominal interest rate, NAR, charged

 PV  == Present Value

 PMT == Periodic Payment

 FV  == Future Value

 CF == Compounding Frequency per year

 PF == Payment Frequency per year



Normal values for CF and PF are:

   1   == annual

   2   == semi-annual

   3   == tri-annual

   4   == quaterly

   6   == bi-monthly

   12  == monthly

   24  == semi-monthly

   26  == bi-weekly

   52  == weekly

   360 == daily

   365 == daily




      
Converting between nominal and effective interest rate



When a solution for n, PV, PMT or FV is required, the nominal
        interest rate (i) must first be converted to the effective
        interest rate per payment period (ieff). This rate,
        ieff, is then used to compute the selected variable. When a solution
        for i is required, the computation produces the effective interest
        rate (ieff). Thus, we need functions which convert from i to ieff, and
        from ieff to i.


To convert from i to ieff, the following expressions are used:

Discrete Interest:     ieff = (1 + i/CF)^(CF/PF) - 1

Continuous Interest: ieff = e^(i/PF) - 1 = exp(i/PF) - 1



To convert from ieff to i, the following expressions are used:

Discrete Interst:      i = CF*[(1+ieff)^(PF/CF) - 1]

Continuous Interest: i = ln[(1+ieff)^PF]



Note
NOTE: in the equations below for the financial transaction,
          all interest rates are the effective interest rate, “ieff”. For the
          sake of brevity, the symbol will be shortened to just “i”.


The basic financial equation



One equation fundamentally links all the 5 variables. This is
        known as the fundamental financial equation:


PV*(1 + i)^n + PMT*(1 + iX)*[(1+i)^n - 1]/i + FV = 0



  Where: X = 0 for end of period payments, and

         X = 1 for beginning of period payments



From this equation, functions which solve for the individual
        variables can be derived. For a detailed explanation of the derivation
        of this equation, see the comments in the file src/calculation/fin.c
        from the GnuCash source code. The A, B, and C variables are defined
        first, to make the later equations simpler to read.


A = (1 + i)^n - 1

B = (1 + iX)/i

C = PMT*B



n = ln[(C - FV)/(C + PV)]/ln((1 + i)

PV = -[FV + A*C]/(A + 1)

PMT = -[FV + PV*(A + 1)]/[A*B]

FV = -[PV + A*(PV + C)] 



The solution for interest is broken into two cases.  

The simple case for when  PMT == 0 gives the solution:

i = [FV/PV]^(1/n) - 1





The case where PMT != 0 is fairly complex and will not be
        presented here. Rather than involving an exactly solvable function,
        determining the interest rate when PMT !=0 involves an iterative
        process. Please see the src/calculation/fin.c source file for a
        detailed explanation.

Example: Monthly Payments



Let’s recalculate the section called “Example: Monthly Payments”, 
        this time using the
        mathematical formulas rather than the Loan Repayment Calculator. What is
        your monthly payment on a $100000 30 year loan at a fixed rate of 4%
        compounded monthly?
First, let’s define the variables: n = (30*12) = 360, PV =
        100000, PMT = unknown, FV = 0, i = 4%=4/100=0.04, CF = PF = 12, X = 0
        (end of payment periods).
The second step is to convert the nominal interest rate (i) to
        the effective interest rate (ieff). Since the interest rate is
        compounded monthly, it is discrete, and we use: ieff = (1 +
        i/CF)^(CF/PF) - 1, which gives ieff = (1 + 0.04/12)^(12/12) - 1, thus
        ieff = 1/300 = 0.0033333.
Now we can calculate A and B. A = (1 + i)^n - 1 = (1 +
        1/300)^360 - 1 = 2.313498. B = (1 + iX)/i = (1 + (1/300)*0)/(1/300) =
        300.
With A and B, we can calculate PMT. PMT = -[FV + PV*(A +
        1)]/[A*B] = -[0 + 100000*(2.313498 + 1)] / [2.313498 * 300] =
        -331349.8 / 694.0494 = -477.415296 = -477.42.
Answer: You must make monthly payments of 477.42.



Automobile Loan (How-To)



The Automobile Loan, or in common terms, Car Loan, is treated more
    or less exactly as the House loan. The only difference is different
    accounts, and different interest rates.
Basic Car Loan Account Structure



-Asset

    -Current Assets

        -Savings Account

    -Fixed Assets

        -Car

-Liability

   -Loans

       -Car Loan

-Expenses

   -Interest

       -Car Loan Interest

   -Car Loan Adm Fees

For more information, please check the section called “House Mortgage (How-To)”

Selling Shares



Entering an investment you are selling is done in the same way as
    buying one (see the section called “Buying New Shares”) except the total cost 
    of the transaction is entered in the
    Sell column and the Shares
    column is entered as a negative amount. The net proceeds from the sale
    should be transferred from the stock account to your bank or brokerage
    account.
The proper recording of the stock sale *must* be done using a split
    transaction. In the split transaction, you must account for the profit (or
    loss) as coming from an Income:Capital Gains account 
    (or Expenses:Capital Loss). To balance this income,
    you will need to enter the stock asset
    twice in the split. Once to record the actual sale (using the correct
    number of shares and correct price per share) and once to balance the
    income profit (setting the number of shares to 0 and price per share to
    0).
Note
In order to get GnuCash to commit this
      zero-share, zero-price split to the transaction, you *must* 
      Tab out of the split. If you use the 
      Enter key, GnuCash
      will convert the split into shares of the commodity.

In the split transaction scheme presented below, the symbol
    NUM_SHARES is the number of shares you are selling, SELL_PRICE is the
    price for which you sold the shares, GROSS_SALE is the total price for
    which you sold shares, equal to NUM_SHARES*SELL_PRICE. PROFIT is the
    amount of money you made on the sale. COMMISSIONS are the brokerage
    commissions. NET_SALE is the net amount of money received from the sale,
    equal to GROSS_SALE - COMMISSIONS.
Table 8.1. Selling Stock using Split Transaction Scheme
	Account	Number of Shares	Share Price	Total Buy	Total Sell
	Assets:Bank ABC	 	 	NET_SALE	 
	Assets:Stock:SYMBOL	0	0	PROFIT	(Loss)
	Expenses:Commissions	 	 	COMMISSION	 
	Assets:Stock:SYMBOL	-NUM_SHARES	SELL_PRICE	 	GROSS_SALE
	Income:Capital Gains	 	 	(Loss)	PROFIT




If you will be recording the sale of the stock as a capital gain (or
    loss), please see Chapter 9, Capital Gains and Chapter 11, Depreciation
    for more information on this topic.
Example - Sale of stock with profit



As an example we will use the AMZN account created in the previous section.
      So you bought 100 shares of AMZN for $20 per
      share, then later sell them all for $36 per share with a commission of $75. In the split
      transaction scheme above, PRICEBUY is $20 (the original buying price),
      NUM_SHARES is 100, TOTALBUY is $2000 (the original buying cost),
      GROSS_SALE is $3600, and finally PROFIT is $1525
      (GROSS_SALE-TOTALBUY-COMMISSION).
Table 8.2. Selling Stock Split Transaction Scheme
	Account	Shares	Price	Buy	Sell
	Assets:Bank ABC	 	 	3525.00	 
	Assets:Brokerage Account:Stock:AMZN	0	0	1600.00	 
	Expenses:Commissions	 	 	75.00	 
	Assets:Brokerage Account:Stock:AMZN	-100	36.00	 	3600.00
	Income:Cap Gain (Long):AMZN	 	 	 	1600.00




[image: Selling Stock Example]An example of selling stock for gain. You bought 100
          shares of AMZN for $20 per share, and sold for $36.



[image: Selling Stock Example]An image of the account tree after the example of
          selling stock for gain. 




Example - Sale of stock with loss



As an example we will use the IBM account created in the previous section.
      You then have bought 51.7598 shares of IBM for $96.6001
      per share, then later sell them all for $90 per share. In the split
      transaction scheme below, PRICEBUY is $96.6001 (the original buying price),
      NUM_SHARES is 51.7598, TOTAL_BUY is $5,000 (the original buying price),
      (Loss) is $341.62, and finally GROSS_SALE is $4658.38. Assume the commission
      was $100.00.
Table 8.3. Selling Shares at loss Split Transaction Scheme
	Account	Shares	Price	Buy	Sell
	Assets:Bank ABC	 	 	4558.38	 
	Assets:Brokerage Account:Stock:IBM	0	0	 	341.62
	Expenses:Commissions	 	 	100	 
	Assets:Brokerage Account:Stock:IBM	-51.7598	90.00	 	4658.38
	Income:Cap Gain (Long):IBM	 	 	341.62	0




Note
You may either enter the loss as a positive number in the
      “buy” column or as a negative number in the “sell”
      column, GnuCash will move the “negative profit”
      to the other column.

[image: Selling Stock at loss Example]Above is a screenshot of the example of selling
          stock. You bought $5000 worth of IBM shares with a stock value of
	  $96.6001, and sold for $90.



[image: Selling Stock at loss Example]An image of the account tree after the example of
          selling stock for loss. 





Chapter 9. Capital Gains



This chapter will present some of the techniques used to keep track of
  the unrealized and realized gains and losses, better known as capital gains
  and losses.
Basic Concepts



This chapter will present some of the techniques used to keep track
    of the unrealized and realized gains and losses, better known as capital
    gains and losses.
Certain resellable assets can change value over time, such as
    stocks, bonds, houses, or cars. Some assets (eg: a stock) could increase
    in value, some (eg: a car) could decrease in value. It is important to be
    able to track some of these time-dependent asset valuations, this chapter
    will show you how.
Probably everything you own will increase or decrease in value over
    time. So, the question is for which of these assets should you track this
    changing value? The simple answer is that you only need to track this for
    items which could be sold for cash in the future or which relate to
    taxation.
Consumable and disposable items (eg: food, gas for your car, or
    printer paper) are obviously not involved. Thus, even though the new
    clothes you recently bought will certainly depreciate, you would not want
    to track this depreciation since you have no intention of reselling the
    clothes and there is no tax implications to the depreciation on clothing.
    So, for this example, the purchase of new clothes should be recorded as a
    pure expense... you spent the money, and it is gone.
Asset appreciation occurs when something you own increases in value
    over time. When you own an asset which has increased in value, the
    difference between the original purchase price and the new value is known
    as unrealized gains. When you sell the asset, the
    profit you earn is known as realized gains or
    capital gains. An example of an asset from which you
    could have unrealized gains, and eventually capital gains, is stock in a
    publicly traded company.


Estimating Valuation



As mentioned in the introduction to this chapter, capital gains are
    the profits received from the sale of an asset. This section will describe
    how to record capital gains in GnuCash.
The accounting methods for handling asset appreciation differs
    somewhat from depreciation because typically you are only concerned with
    the moment you sell the asset and realize the capital gains. This is
    opposed to the continuous nature of tracking depreciation. Capital gains
    are an important subject in the world of taxation, because governments
    tend to be quite interested in taxing capital gains in one manner or
    another.
Note
As always, there are exceptions. If you hold a bond that pays all
      of its interest at maturity, tax authorities often require that you
      recognize interest each year, and refuse this to be treated as a capital
      gain. Consult the appropriate tax codes to determine the preferred
      treatment for each type of asset you have which may be affected by
      capital gains taxes.

Estimating the increasing value of assets is generally not simple,
    because often it is difficult to know its exact value until the moment it
    is sold.
Securities traded daily on open markets such as stock exchanges are
    possibly the easiest type of asset to predict the value of, and selling
    the asset at market prices may be as simple as calling a broker and
    issuing a Market Order. On the other hand, estimating the value of a house
    is more difficult. Homes are sold less often than stocks, and the sales
    tend to involve expending considerable effort and negotiations, which
    means that estimates are likely to be less precise. Similarly, selling a
    used automobile involves a negotiation process that makes pricing a bit
    less predictable.
Values of collectible objects such as jewelry, works of art,
    baseball cards, and “Beanie Babies” are even harder to estimate. The
    markets for such objects are much less open than the securities markets
    and less open than the housing market. Worse still are one-of-a-kind
    assets. Factories often contain presses and dies customized to build a
    very specific product that cost tens or hundreds of thousands of dollars;
    this equipment may be worthless outside of that very specific context. In
    such cases, several conflicting values might be attached to the asset,
    none of them unambiguously correct.
The general rule of thumb in accounting for estimating unrealized
    gains (or loses) is that you should only revalue assets such as stocks
    which are readily sellable and for which there are very good estimates of
    the value. For all other assets, it is better to simply wait until you
    sell them, at which time you can exactly determine the capital gains. Of
    course, there is no hard rule on this, and in fact different accountants
    may prefer to do this differently.

Account Setup



Your default account currency is set in the Account tab 
    under Edit → Preferences
    (GnuCash → Preferences on Mac OS X).
    You should set this parameter correctly, as it will save you much time when building
    your account structure.
Similarly, GnuCash offers an option to
    set your preferred currency for displaying reports (like the balance
    sheet and income statement). The option is called Default
    Report Currency, and is in the Reports
    tab of the GnuCash Preferences screen.
    You’ll want to set both options when you start using
    GnuCash because if (for example) your accounts
    are all in Canadian Dollars but the generated reports are all in US
    Dollars, the reports will just say that there is “no
    data/transactions (or only zeroes) for the selected time
    period”.
When you create a new account, you have the option to define the
    commodity. For currency accounts, you can specify any one of the hundreds
    of currencies supported by GnuCash by simply selecting it from the
    currency commodity list. You will notice that the default currency is
    always whatever you have defined in the preferences. So, if you mostly
    work with Euros, but have the occasional Ethiopian Birr account, be sure
    to set your preferences to Euro.
As an example, let’s set up a typical bank account scenario where
    you mostly work in US Dollars, but do also have a European bank account
    using the Euro currency, as well as one bank account in Hong Kong using
    Hong Kong Dollars. So, setup 3 bank accounts, one using the Euro currency,
    one in US Dollars, and another in Hong Kong Dollars. One possible account
    structure for this would be:


-Assets                          (USD)

   -Current Assets           (USD)

      -US Bank                 (USD)

      -European Bank       (EUR)

      -HK Bank             (HKD)

-Equity                          (USD)

   -Opening Balances

      -USD            (USD)

      -EUR            (EUR)   

      -EUR            (HKD)



Note: the currency of each account is shown in parenthesis.

 

Since in this example you mostly work in USD, all of the parent
    accounts are set to USD. Of course, if you mostly work in Euros, you could
    change the currency of these parent accounts to EUR. The totals shown in
    the account tree window will always be converted to the currency of each
    particular account. Notice, we also set up 3 Starting Balances equity
    accounts, used to initially populate the 3 banks.
Note
You could also setup just a single Starting Balance account and
      use a currency transfer to populate the “different currency” accounts.
      However, this is more advanced option, which is explained in a later
      section (the section called “Purchase of an asset with foreign currency”.

Below you see the result of this example, in which you start with
    USD 10,000, EUR 10,000 as well as HKD 10,000 in the three bank accounts.
    Notice that the total of the parent accounts only show the value of the
    currency of sub-accounts with matching currencies. In the future you can
    setup the exchange rates between the currencies, and the parent accounts
    will calculate the converted value of all sub-accounts. See the later
    section (the section called “Recording/Updating Currency Exchange (How-To)”) on how to do this.
[image: Initial multi currency Account Bank Setup]Initial setup of 3 bank accounts with different
        currencies. 



Notice that the "Total (Report)" column is being displayed. This is
    configured in the column header row, select Arrow
    down and select “Total(USD)”.
User-Defined Currencies



Usually when we talk about currencies, we mean
      government-backed currencies (or more precisely, currencies defined
      in the international standard called ISO 4217).
      GnuCash does not allow you to create your
      own currencies. If you want to track non-ISO
      currencies, you can use either of two workarounds, depending on which
      fits your needs better.
Let’s say for example that you want to track RewardMiles,
      which count how many loyalty points you’ve earned by buying
      from a certain group of businesses. The account which tracks your
      RewardMiles will be Assets:Other:LoyaltyGroupRewardMiles.
The first method is to define a new security, of type FUND,
      called RewardMiles. This is pretty straightforward–when you
      create the new LoyaltyGroupRewardMiles account, just set the account
      type to Stock or Mutual
      Fund, click the Select... button
      next to the Security/currency: box, and click
      New to define a new security of type
      FUND.
This is not really what the stock and mutual fund account types
      are meant for, but GnuCash usually lets you
      decide how you want to use it, instead of dictating. The downside is
      that you’ll have to enter a “price” for every
      transaction involving RewardMiles, because
      GnuCash needs the prices to figure out the
      monetary value of RewardMiles and treat them as one of your
      assets.
The second method is to use one of the “dummy”
      currencies to track the RewardMiles. The dummy currencies are
      “XTS (Code for testing purposes)” and “XXX (No
      currency)”. If you use one of these for your
      LoyaltyGroupRewardMiles account, you can enter transactions into the
      account without having to enter share prices for every transaction.
      And, you can keep using the same two dummy currencies to track all
      sorts of amounts–vacation dollars earned and used so far this
      year, vacation hours earned and used, health insurance benefits
      allowance used and remaining, and so on. You can well imagine that
      GnuCash can be used as a hub for all sorts
      of personal metrics, in addition to finances.
The drawback with this second method is that you cannot define exchange rates for
      the dummy currencies to convert them to ISO
      currencies. If you want to do that, you really should use the first
      method.


Recording Purchases in a Foreign Currency (How-To)



You can do it in two different ways.
1) Use GnuCash build in currency exchange between accounts when you
    do your transactions. This is mainly used for one time transactions, and
    nothing which happens regularly.
2) Use separate accounts for this Purchase, where all involved
    accounts use the same currency. This is the recommended method, since it
    allows much better tracking and follow up. In this way, you do one
    currency exchange transaction, and after that you do normal
    transactions.
The rest of this section will explain more based upon option
    2).
Purchase of an asset with foreign currency



Your normal place of residence is in Florida, therefore you are
      using USD as your default currency. But, you do like to travel to the
      Bahamas and go fishing. You like it so much that you decided to purchase a
      boat there. To do this, you opened a bank account in Jamaica, moved some
      money from the US, and then purchased your dream boat (smallest
      version).
To record this in GnuCash we use the following basic account
      structure:


-Assets                          (USD)

   -Current Assets           (USD)

      -US Bank                 (USD)

      -Jamaican Bank       (JMD)

   -Fixed Assets           (USD)

      -Boat                (JMD)

-Equity                          (USD)

   -Opening Balances

      -USD            (USD)



Note: the currency of each account is shown in parenthesis.

 

First you need to transfer some money ($10,000) to Jamaica, and
      you use your normal US bank account (with a balance of $100,000) for
      that. The bank gives you an exchange rate of USD 1 = JMD 64, but charges
      you USD 150 to transfer the money.
[image: Currency transfer]Transfer money to Jamaica



Select the Jamaica transaction line ($9,850.00), right click and
      select Edit Exchange Rate
[image: Edit Exchange rate]A dialog window where the exchange rate in a currency
          transaction is specified



As Exchange Rate, you enter 1 USD = 64 JMD, since this is the rate
      your bank gave. Press ok in the Transfer Funds (Edit Exchange Rate)
      window, and then save this split transaction. Below is how it now looks
      in the main Chart of Accounts.
[image: Chart of Accounts before purchasing the boat]Chart of Accounts before purchasing the
          boat



You find the boat, and since it’s a bargain at JMD 509,000 you
      decide to buy it. To record this transaction in GnuCash, you will need
      to enter a simple transaction in Assets:Current Assets:Jamaican Bank
      withdrawing 509,000 and transferring it to Assets:Fixed Assets:Boat
[image: Chart of Accounts after purchasing the boat]Chart of Accounts after purchasing the
          boat



The Chart of Accounts now reflects that your bank account has been 
      reduced with the value of the boat (JMD 509,000), and that your Fixed Assets
      boat account has been increased with the same amount. If you also have turned
      on the CoA (Column Choice) "Total (USD)" you will see the corresponding
      value in USD. The USD value will always reflect the latest currency exchange
      rate you have either automatically or manually updated GnuCash with.
      

Purchasing foreign stocks



This example will show how to purchase stocks that are priced in a
      different currency than your normal currency.
Assume that you live in New York and therefore you have set the
      default currency to USD. You decide to purchase a stock traded in Hong
      Kong that is priced in HKD. You would also like to be able to track the
      various income and expense amounts per stock and broker.
You decide to purchase stock in the Beijing Airport (Hong Kong).
      (After all, the 2008 Olympics in Beijing have finished and the price has
      returned to Earth.)
Note

         The above stock (Beijing Airport) has been chosen only as an example,
         and should not be taken as any kind of stock purchase advice.
      

You need to find out what the stock ticker is for this 
      stock. To do this, you do a bit of investigation on the Internet, and
      in particular on Yahoo! Finance - Ticker
      Symbol Lookup (http://finance.yahoo.com/lookup).
      This gives you the following:
	Beijing Airport has the Stock Symbol
          0694.HK at Yahoo



Since we wanted to be able to track all various income and expense amounts,
      we come up with the following Account structure:


Assets:Investments:Brokerage Accounts:Boom:0694.HK     (Beijing Airport)

Assets:Investments:Brokerage Accounts:Boom:Bank        (HKD)

Equity:Opening Balances:HKD                            (HKD)

Expenses:Commissions:Boom.0694.HK                      (HKD)

Income:Investments:Dividend:Boom:0694.HK               (HKD)

      

The Chart of Accounts looks like this after creating all the
      needed accounts:
[image: Chart of Accounts for international stocks]Chart of Accounts for international
          stocks



The stock definition can be seen in the Security Editor.
      (Tools+Security Editor)
      
[image: International securities]International securities



If you have not moved money (HKD 50,000) into the brokerage’s
      cash account (Assets:Investments:Brokerage Account:Boom:Bank), do so
      now, either using the Equity (HKD) account, or an existing bank account
      (Currency Transfer).
Let’s assume that the stock price is HKD 3 per share. To record the
      purchase, open the brokerage’s HKD cash account
      (Assets:Investments:Brokerage Account:Boom:Bank), and enter
      the following:


Buy Stocks

	Assets:Investments:Brokerage Account:Boom:Bank  Withdrawal 50,000

	Expenses:Investments:Commission:Boom_HKD	Deposit 500

	Assets:Investments:Brokerage Account:Boom:0694  Deposit 49,500 (16,500 shares)



If the exchange rate dialog box does not appear automatically,
      right-click on the stock row, and select Edit
      Exchange Rate. Enter the number of shares (16,500) as the
      To Amount.
      
[image: Transfer Funds]Setting the number of shares in the Transfer Funds dialog



If you return to the Chart of Accounts, you will see the
      purchased shares reflected in the stock account’s total.
[image: Purchased international stocks]
            Chart of Accounts with some international stocks
          



However, as you can see, the USD totals may be zero if
      GnuCash doesn’t have an exchange rate between USD and HKD.
      To fix this, go to Tools → Price
      Editor
      and click the Get Quotes button to
      automatically retrieve the exchange rates you need.
Note
This example shows how stock can be purchased in any currency
         by entering the transaction in the register of the cash account used
         to make payment. It is also possible to enter the purchase
         in the stock account’s register, but proceed with caution!
         When doing it that way, the stock is assumed to be priced
         in the currency of the stock account’s parent.
In this example, the stock account’s parent
         (Assets:Investments:Brokerage Account:Boom) is denominated in HKD.
         Since this is same currency as the stock price, the purchase
         can be safely entered in the stock account’s register.



Account Setup



As with most accounting practices, there are a number of different
    ways to setup depreciation accounts. We will present here a general method
    which should be flexible enough to handle most situations. The first
    account you will need is an Asset Cost account
    (GnuCash account type Asset), which is simply a place where you record
    the original purchase of the asset. Usually this purchase is accomplished
    by a transaction from your bank account.
In order to keep track of the depreciation of the asset, you will
    need two depreciation accounts. The first is an Accumulated
    Depreciation account in which to collect the sum of all of the
    depreciation amounts, and will contain negative values. In GnuCash, this
    is an account type asset. The Accumulated Depreciation
    account is balanced by a Depreciation Expense account,
    in which all periodic depreciation expenses
    are recorded. In GnuCash, this is an account type
    expense.
Below is a generic account hierarchy for tracking the depreciation
    of 2 assets, ITEM1 and ITEM2. The Asset Cost accounts are balanced by
    the Bank account, the Accumulated Depreciation account is balanced by
    the Expenses:Depreciation account.


-Assets

   -Fixed Assets

      -ITEM1

         -Cost                (Asset Cost account)

         -Depreciation     (Accumulated Depreciation account)

      -ITEM2

         -Cost                (Asset Cost account)

         -Depreciation     (Accumulated Depreciation account)

   -Current Assets

      -Bank

-Expense

   -Depreciation        (Depreciation Expense account)

  

One of the features of the account hierarchy shown above is that you
    can readily see some important summary values about your depreciating
    asset. The Assets:Fixed Assets:ITEM1 account total shows you the current
    estimated value for item1, the Assets:Fixed Assets:ITEM1:Cost shows you
    what you originally paid for item1, Assets:Fixed Assets:ITEM1:Depreciation
    shows you your accrued depreciation for item1,
    and finally, Expenses:Depreciation demonstrates the total accrued
    depreciation of all your assets.
It is certainly possible to use a different account hierarchy. One
    popular account setup is to combine the Asset Cost
    and Accrued Depreciation asset accounts. This has the
    advantage of having fewer accounts cluttering your account hierarchy, but
    with the disadvantage that to determine some of the summary details
    mentioned in the paragraph above you will have to open the account
    register windows. As with most things, there are many ways to do it, find
    a way that works best for you.
The actual input of the depreciation amounts is done by hand every
    accounting period. There is no way in GnuCash (as of yet) to perform the
    depreciation scheme calculations automatically, or to input the values
    automatically into the appropriate accounts. However, since an accounting
    period is typically one year, this really is not much work to do by
    hand.

Initial Setup



To set up GnuCash to handle accounts receivable for a company two
    preliminary things must be done. The first is to build an appropriate
    Account Hierarchy and the second is to register the company in
    GnuCash.
Account Setup



There are many different ways to set up a business account
      hierarchy. You can start with the Business Accounts setup which is
      available from the New Account Hierarchy assistant, or you could build one
      manually. To access the prebuilt Business Accounts, start GnuCash and
      click on File → New File and
      proceed until you see the list of available accounts, select Business
      Accounts.
The prebuilt Business Account hierarchy will not meet your needs
      exactly. You will need make adjustments for the hierarchy to function
      well with your particular situation. It should be close enough that it
      is recommended you begin with it.
Accounts Receivable (or A/R) refers to products or services
      provided by the company on credit for which payment has not yet been
      received. This is represented on the balance sheet as an asset, because
      you expect to receive payment soon. To use GnuCash’s integrated accounts
      receivable system, you must first set up an account (usually a
      sub-account under Assets) defined with account type
      A/Receivable. It is within this account that the
      integrated A/R system will place transactions.


Basic A/R Account Hierarchy:



-Assets

   -Checking

   -Accounts Receivable

-Income

   -Sales

  

You need to add additional asset, expense, and income accounts to
      this hierarchy for it to be useful. The important aspects of this
      hierarchy are the use of an income account and the Accounts Receivable
      asset account, with account type set to
      A/Receivable.
Note
You do not need to create an individual A/R account for each
        customer. GnuCash keeps track of customers internally and provides
        per-customer reports based on the internal tracking.


Company Registration



After you have built the account structure, register the GnuCash
      file as belonging to your company. To register your company, select the Business tab
      in the Book Options window accessible by selecting 
      File → Properties. Here you can:
	Enter the name of your company along with contact information
          such as your phone number, fax number, e-mail address and website
          URL.

	Enter your company’s tax payer id number in the
          Company ID field.

	Select default tax tables applicable to your most common
          customers and vendors.





Customers



Customers are people or companies to whom you sell goods or
    services. They must be registered within the A/R system.
New



To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer information, such as
      Company Name, Address, Phone, Fax, etc.
[image: New Customer Registration Window]New Customer Registration Window




Find and Edit



To search for an existing customer, use the Business → Customer → Find Customer window. You select a customer to
      View/Edit from the results of the search. This
      window is also used to look up customers when creating invoices and
      processing payments.
[image: Find Customer Window]Find Customer Window 



If many customers match the search criteria you provide, the
      search can be refined by running an additional search within the current
      results. The current result set is searched when the Refine
      Current Search radio button is selected. In fact, GnuCash
      selects this option for you after you run the initial search.
If the customer you are searching for does not match the supplied
      search criteria, change the search criteria, click the New
      Search radio button and then the Find
      button. The relevant step is the New Search
      selection. If the customer is not in the result of the original search,
      and you only search within this set, the customer cannot be found,
      regardless of new search criteria.
Note
To return a list of all registered active customers, set the
        search criterion to matches regex, and place a
        single dot "." in the text field area. Make sure Search only
        active data is checked, then click
        Find. The regular expression "." means to match
        anything.



Invoices



An invoice is the paperwork you send to a customer to request
    payment for products or services rendered. GnuCash can generate and track
    invoices.
A credit note is the paperwork you send to a customer to correct
    products or services rendered that were incorrectly invoiced. GnuCash can generate and track
    credit notes via the same menu entries as invoices.
Note
This section applies to both invoices and
      credit notes. In order to avoid repeating everything twice and to keep
      the text easier to read it will refer only to invoices. You can apply
      it equally to credit notes. Only where the behaviour of credit notes
      differs from invoices this will be explicitly mentioned.

New



To send an invoice to a customer you must first create the new
      document. To create an invoice use Business → Customer → New Invoice. The
      New Invoice window must be filled in appropriately.
[image: Creating a New Invoice]Creating a New Invoice



When you click the OK button, the
      Edit Invoice window opens.

Edit



From the Edit Invoice window you can enter an itemized list of
      goods and services you sold on this invoice in a manner similar to how the account
      register works. For credit notes you enter an itemized list of goods and
      services you refunded instead.
[image: Edit Invoice Window]Edit Invoice Window 



When you have finished entering all the items, you can
      Post and print the invoice.

Post



When you finish editing an invoice and are ready to print, you
      must Post the invoice. The invoice does not have to
      be posted immediately. In fact, you should only post an invoice when you
      are ready to print it. Posting an invoice places the transactions in an
      accounts receivable account.
[image: Post Invoice Window]Post Invoice Window 




Find



To find an existing invoice, use the Business → Customer → Find Invoice
      menu item. From the results of the search, you can select an invoice
      to edit or view.
Note
Before you can edit a posted invoice, you will need to
        Unpost it.

One of the design goals in GnuCash’s Account Receivable system was
      to allow different processes to get to the same state, so you can reach
      an invoice from different directions based on the way you think about
      the problem:
	You can search for the customer first, then list their
          invoices.

	You can search for invoices by number or by company
          name.

	You can list invoices associated with a customer job.




Print



After you post an invoice, you should print it and send it to your
      customer. To print an invoice use File → Print Invoice menu item.
[image: Invoice Print Output]Invoice Print Output 



Note
You can modify the appearance of the invoice, IE: add a company
        logo, etc. To do so, see the the section called “Changing the Invoice Appearance”.

Invoices can also be printed from the main window by selecting
      Reports → Business Reports → Printable Invoice from the main menu. The
      resulting report window states that no valid invoice is selected. To
      select the invoice to print:
	Use the Options Toolbar button or select
          Edit → Report Options from
          the main menu.

	Select the General tab of the report
          options dialog.

	Click the Select button next to the
          Invoice Number field.

	Search for the invoice as usual.



You can also print invoices from within the Process Payment
      dialog. See the the section called “Process Payment” for instructions on
      how to do so.

Assign Starting Invoice Number



By default, GnuCash starts with invoice number 1 and increments from there. You can
      manually type an invoice number into the text box each time you create
      an invoice, but this gets tiring and sooner or later leads to duplicate
      numbers.
You can change the starting invoice number if it is important you.
      Use File → Properties, access
      the Counters tab, change the Invoice number value to be
      one less than your desired starting invoice number and click the OK button or the 
      Apply button.


Bills



A bill is a request for payment you receive from a vendor.  GnuCash can track bills.
A credit note is the document you receive from a vendor to correct
    products or services rendered that you were incorrectly charged for on a bill. GnuCash can generate and track
    credit notes via the same menu entries as bills.
Note
This section applies to both bills and
      credit notes. In order to avoid repeating everything twice and to keep
      the text easier to read it will refer only to bills. You can apply
      it equally to credit notes. Only where the behaviour of credit notes
      differs from bills this will be explicitly mentioned.

New



When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill.  To create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window appropriately.
[image: New Bill Registration Window]New Bill Registration Window
	       



When you click the OK the Edit Bill opens.

Edit



From the Edit Bill window you can enter an itemized list of
      goods and services you purchased, in a manner similar to how the account
      register works. For credit notes you enter an itemized list of goods and
      services the vendor refunded instead.
[image: Edit Bill Window]Edit Bill Window



When you have finished entering all the items, Post the bill. 

Post



When you finish editing a bill, you should Post the bill.  You do not have to post the bill,
      you can close it and return to it later. You have to post the bill eventually.  Posting a bill places its transactions into an accounts payable account.
      The Post Bill window appears and asks you to enter information:
[image: Post Bill Window]Post Bill Window
	       




Find



To find an existing bill, use the Business → Vendor → Find Bill menu item.  From the results of the search, you can select a bill to edit, or view.
Note
Before you can edit a posted bill, you will need to Unpost it.

Note
There are other ways to access an existing bill.  These are similar to accessing invoices for your customers.  See the section called “Find” for more information.



Chapter 15. Budgets




 This chapter explains how to create and use budgets with GnuCash. 
  
Basic Concepts



A budget is a tool for estimating expected income and expenses.
 You can use it to help you plan how you intend for your finances to
 change over a period of time, and to examine how your actual
 financial transactions for the period compare to your planned
 transactions.
The budgeting concept is quite general, so GnuCash offers a
budgeting tool that is both simple and flexible.  You, the user, have
to decide how complex or simple you want to make your budget.  This
guide will help you make some of those decisions.
Terminology



There are a few helpful terms listed
  below that will be used to discuss budgeting.
	Budget - A financial plan describing
    the expected revenues and/or disbursements for a particular time
    period

	Cash Budget - A budget planning for
    expected cash receipts and cash disbursements.  This type of
    budget tracks cash flow -- where your money comes from, where it
    goes, and, of course, how much.

	Expense Budget - A budget chiefly for
    planning what you spend your money on.  This type of budget tracks
    your expenses.  It is typically not concerned with things like
    appreciation or repayment of liabilities.  However, it would
    account for interest charges.  For example, if you buy $100 worth
    of groceries with your credit card, you incur an $100 expense for
    groceries, and a $100 liability to your credit card company.  When
    you pay the credit card bill for $110, you are incurring an
    additional interest expense of $10.  An expense budget plans for
    the transaction of buying the groceries and paying the interest,
    but not the transaction of repaying the credit card
    company.

	Capital Budget - A budget that
    describes a plan for paying for a large future expense, often
    through a combination of saving and borrowing money.  Note:
    Capital budgets can sometimes get quite complex because they can
    try to answer the question "Can we afford to do such-and-such?" by
    exploring various hypothetical scenarios that can involve
    hypothetical accounts.  

	Budget Period - The period of time
    during which the plan is expected to take place.  The most common
    budget periods are annual and monthly.  Sometimes, you may budget
    for several consecutive periods at once, for convenience or for
    finer-grained planning.  For example, an annual budget may include
    12 monthly budget periods.






General Information



Q: Can I run GnuCash on Windows?



A: Yes. Starting with release 2.2.0, GnuCash is also available on Windows.
Other related options would be colinux, VMWare and a windows-based X-server hosting a remote GnuCash session.

Q: I heard it is too hard to compile GnuCash!



A: This was probably true at the time when 1.6.0 was released. It is no longer true today, as almost every distribution ships with all the necessary libraries (except g-wrap, which means there is in fact “one” extra library to be installed before compiling GnuCash). However, by default, distributions won’t install the development packages of the required libraries, so you might need to start your distribution’s installer program and tell it to install not only the library packages but also the -devel packages. In general, it was noted that this problem concerns many applications in the gnome domain, and this also boils down to the fact that there is no such thing as “one monolithic gnome package”.

Q: Is there a batch mode (non-interactive) available for GnuCash, for building reports, etc?



A: No, for now GnuCash must be run interactively.

Q: Can multiple people access the same datafile in GnuCash?



A: You can have multiple people with access to the same datafile, but they cannot use the data file simultaneously.
To setup multi-person access, all the people must have read/write access to the directory containing the file (to read the other’s created files, and to create new files).  One way to do this is by creating a user group and setting the data directory to be owned by the shared group and set to mode 2775. The “2” makes the directory setgid which copies the permissions to all files.

Q: Why is GnuCash written in C?



A: The core functionality of GnuCash is written in C, but do not forget that much of this can be accessed through Guile (scheme).  There are a number of reasons for why GnuCash is written in C.  The first is historical, GnuCash was started in 1996 (or maybe even earlier!) and many of the OOP (C++, Java, Python) compilers were not yet mature and standarized enough on the variety of platforms considered at that time, so C was the only option at that time.  A second reason is because the standard GUI GnuCash uses is GTK, which is written in C.

Q: Why don’t you rewrite GnuCash in programming language xyz so that I can contribute easily?



A: The quick answer is “We won’t”. The longer answer is complex but still amounts to “We won’t”. GnuCash is a large body of code maintained by a small group of developers who are comfortable in C and Scheme (Guile). Actually, 80% of it is in C and approx. 13% is in Scheme/Lisp. There is no valid reason that would justify rewriting this amount of existing code in a newer language. Also, creating language bindings to recent languages such as Python or Ruby or (insert your favourite language here) is labor intensive, and we’re already stretched pretty thin maintaining and developing the existing code.
Having said that, this is an open source project and you’re free to do with it or contribute what you want. Just don’t expect much support if the reason for your changes is that you’re not willing to learn C or Scheme. Also, GnuCash used to have SWIG bindings (http://www.swig.org) which have been used for some perl programming code. According to a list discussion, these SWIG bindings might still be a way to include other languages into GnuCash, but currently they are unused and unmaintained.

Q: I really want feature XYZ but GnuCash doesn’t have it. How do I get it added?



A: Ask nicely. :-) You can file an enhancement request at http://bugzilla.gnome.org/enter_bug.cgi?product=GnuCash. Please bear in mind to describe your proposed enhancement as verbosely as possible. The trick here is to learn how to give the best information to the programmers about what your proposed new feature should do. If you want to speed up development significantly, consider donating some money as described on GnuCashDevelopment.

Q: Is there a web interface available for GnuCash?



A: No

Q: How can I provide security for GnuCash data using CFS, etc.)



A: Unanswered

Q: How can I contribute to the GnuCash project?



A: We’re working on a more formal process, but for now you should subscribe to the mailing list at http://lists.gnucash.org/mailman/listinfo/gnucash-user and http://lists.gnucash.org/mailman/listinfo/gnucash-devel and discuss what you can contribute with the participants on the lists. Please be aware that GnuCash is a large body of code written in C and Scheme (see the FAQ above, “Why is GnuCash written in C?” if you want to know why). If these are languages that you are not willing to work with, consider contributing in other ways.

Q: I think I found a bug. How do I report it?



A: First of all, try to verify that it is indeed a bug and that it has not been reported before. Search the mail list archives (see FAQ above). Then search the Gnome Bugzilla database.
If you feel you have indeed found a bug, you can then report it at http://bugzilla.gnome.org/enter_bug.cgi?product=GnuCash. Please bear in mind to report your bug as verbosely as possible. The trick here is to learn how to give the best information to the programmers about how to reproduce bugs. A Programmer will usually only be able to fix a bug they can see, if you can’t make the programmer see your bug, it won’t get fixed!


Appendix E. GNU Free Documentation License


      Version 1.1, March 2000
    

Copyright © 2000 Free Software Foundation, Inc.


	
Free Software Foundation, Inc. 59 Temple Place, 

        Suite 330, Boston, MA  

        02111-1307  USA

 
	Everyone is permitted to copy and distribute verbatim copies of this 
        license document, but changing it is not allowed.
      




0. PREAMBLE




      The purpose of this License is to make a manual, textbook, or
      other written document “free” in the sense of
      freedom: to assure everyone the effective freedom to copy and
      redistribute it, with or without modifying it, either
      commercially or noncommercially. Secondarily, this License
      preserves for the author and publisher a way to get credit for
      their work, while not being considered responsible for
      modifications made by others.
    

      This License is a kind of “copyleft”, which means
      that derivative works of the document must themselves be free in
      the same sense. It complements the GNU General Public License,
      which is a copyleft license designed for free software.
    

      We have designed this License in order to use it for manuals for
      free software, because free software needs free documentation: a
      free program should come with manuals providing the same
      freedoms that the software does. But this License is not limited
      to software manuals; it can be used for any textual work,
      regardless of subject matter or whether it is published as a
      printed book. We recommend this License principally for works
      whose purpose is instruction or reference.
    


3. COPYING IN QUANTITY




      If you publish printed copies of the Document numbering more than 100,
      and the Document’s license notice requires Cover Texts, you must enclose
      the copies in covers that carry, clearly and legibly, all these
      Cover Texts: Front-Cover Texts on the front cover, and
      Back-Cover Texts on the back cover. Both covers must also
      clearly and legibly identify you as the publisher of these
      copies. The front cover must present the full title with all
      words of the title equally prominent and visible. You may add
      other material on the covers in addition. Copying with changes
      limited to the covers, as long as they preserve the title of the
      Document and satisfy these
      conditions, can be treated as verbatim copying in other
      respects.
    

      If the required texts for either cover are too voluminous to fit
      legibly, you should put the first ones listed (as many as fit
      reasonably) on the actual cover, and continue the rest onto
      adjacent pages.
    

      If you publish or distribute Opaque copies of the Document numbering more than 100,
      you must either include a machine-readable Transparent copy along with
      each Opaque copy, or state in or with each Opaque copy a
      publicly-accessible computer-network location containing a
      complete Transparent copy of the Document, free of added
      material, which the general network-using public has access to
      download anonymously at no charge using public-standard network
      protocols. If you use the latter option, you must take
      reasonably prudent steps, when you begin distribution of Opaque
      copies in quantity, to ensure that this Transparent copy will
      remain thus accessible at the stated location until at least one
      year after the last time you distribute an Opaque copy (directly
      or through your agents or retailers) of that edition to the
      public.
    

      It is requested, but not required, that you contact the authors
      of the Document well before
      redistributing any large number of copies, to give them a chance
      to provide you with an updated version of the Document.
    

10. FUTURE REVISIONS OF THIS LICENSE




      The Free Software
      Foundation may publish new, revised versions of the GNU
      Free Documentation License from time to time. Such new versions
      will be similar in spirit to the present version, but may differ
      in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.
    

      Each version of the License is given a distinguishing version
      number. If the Document
      specifies that a particular numbered version of this License
      “or any later version” applies to it, you have the
      option of following the terms and conditions either of that
      specified version or of any later version that has been
      published (not as a draft) by the Free Software Foundation. If
      the Document does not specify a version number of this License,
      you may choose any version ever published (not as a draft) by
      the Free Software Foundation.
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45.220000 AMZN (Amazon.com)
43.920000 AMZN (Amazon.com)
44.400000 AMZN (Amazon.com)
47.870000 AMZN (Amazon.com)
40.500000 AMZN (Amazon.com)
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OEBPS/figures/dep_example.png
gnucash_depreciation - Accounts. g x
fle Edt Miew Actions Business Reports Tols Windows Help
g e
@ Accounts
Account Name v | Tpe Total

v f Assets Asset USD 30,000.00
D Current Assets Asset USD 0.00

~ ) Fixed Assets Asset USD 30,000.00

~ f@ Camera Asset USD 10,000.00

@ Cost Asset USD 10,000.00
Ay G USD 0.00

~ @ Car Asset USD 20,000.00

f Cost Asset USD 20,000.00

# Depreciation  Asset USD 0.00

b fEquity iy USD 30,000.00
< @ Expenses Expense UsD 0.00
A E— UsD 0.00

| usp, grand total

Assets: USD 0.00

Profits: USD 0.00

[
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Stock Split Details

Enter the date and the number of shares you gained or
lost from the stock spit or merger. For stock mergers
(negative spits) use a negative value for the share
distibution. You can also enter  description of the
transaction, or accept the default one.

Date: (117182005 =)

Shares: ((77942'100100 ]

Desciption: [SBC / AT&T merger |

If you want to record a stock price for the spli, enter
it below. You may safely leave it biank.

New Price: (2438 ]

Curency:  [USD (US Dollan [-]






